
BVE Special 

BVE Creator-Converter 
By Sanford Mace 

 

 recently released several objects for BVE. I have received some comments on those 
objects, which implied that I was a pretty good object builder. The truth is that I 
cannot build up objects. I just cannot quite grasp how objects are created. No, the 
objects are not pirated, I did create them, but not in the traditional form. I used two 
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rograms that I wrote, plus Notepad and Structure Viewer to create these objects.   

he two programs that I used were an object creator and an object converter. What I will 
o in this article is show you how I used those programs to create objects that were created 
n a manner similar to the ones I just released.   

f you wish to follow along you will need the following: 

• BVE Object Creator (this will appear as Total Sphere on your desktop - 6th object 
down on the main downloads page) and BVE File Converter Version 2 (37th object down 
on the main downloads page) programs, available free on my homepage 
(http://home.cfl.rr.com/bvefl) and at the Train-sim.com downloads page 
(http://www.train-sim.com/- free to registered users).  

• Mackoy�s Structure Viewer (free download at http://mackoy.cool.ne.jp/make) 

• A text editor such as Notepad 

• Bitmaps BUILD_006, BUILD_019, and BUILD_045 downloaded from 
http://amazingtextures.com/textures/index.php (available free to registered users). 
To download these files go to the site. Directions are for Internet Explorer. In the 
Categories section in about the middle of the page, under the URBAN section, select 
Buildings. 

 

• Then select the building name from the list. This brings the building picture up as a 
photo. Right click the photo and choose Save as or Save picture as (depends on 
the version of Internet Explorer you are using). Choose the VRObjects folder on 
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your desktop. Make sure the file type is BMP. Leave the file name as it appears and 
select Save. If you are going to get more than the three files we suggest you 
register so the site owner knows you are there. 

 

• Irfanview available free at www.irfanview.com. There is a comprehensive tutorial at 
http://home.quicknet.nl/qn/prive/haw.kristel/Irfan-tutorial/Irfanview1.htm. 

 

One minor word of warning: these objects will be fully formed 3D objects. You will not want 
to use many of them in a route because they will impact the frame rate. I create objects like 
this because I use RouteBuilder [see VR October 15, 2005 issue � Ed.] to make my routes, 
and will see the objects from all sides.   

We will create a couple of towers, and a couple of simple buildings. I chose these because 
they are composed of simple objects such as spheres, cylinders, cubes, and pyramids. 
These are all objects that my program can create. For this article we will do some editing of 
the .CSV files. I will give you the values for this set, but to learn more about what they 
mean you may want to look at these tutorials on object building at Luigi Cartello�s web site. 
Scroll down to a �Guide to build graphic objects for BVE simulator in Word format by BVE 
Italia fans (13-8-2003).� 

OK, let�s get started. We will be doing all this work in a folder on your desktop to make it 
easy to find. Create a folder on your desktop called VR objects. Place a copy of BVE Object 
Creator (aka Total Sphere) and the BVE File Converter Version 2 into this folder. It would also 
be useful to place shortcuts to Structure Viewer, Irfanview, and Notepad into this folder; 
and, finally, place the bitmaps that you downloaded from the list above into this folder. You 
will also need a copy of a piece of straight track for reference. Copy one from a route or the 
RouteBuilder library and the associated bitmaps to the same folder.    

For your convenience, we�ve placed the object files and test routes for BVE 2 and BVE 4 at 
the BVE Routes section of the VR Downloads page 
(http://www.virtualrailroader.com/downloads.html). 
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Your First Building To begin, open BUILD_045 with Irfanview and resave as a BMP file 
with 512 x 512 or 256 x 256 pixel size. (Select File Open. In the 
Look in field, select VR OBJECTS and choose BUILD_045.bmp. 
Then select Image > Resize/Resample. Uncheck Preserve 
aspect Ratio at the bottom. Make the width and height the values 
you choose below. Click OK, Then choose File > Save and resave 
the file.)  

The bigger file will look better, but it is HUGE. See Bitmap Size 
sidebar. 

Now open the Object Creator (aka Total Sphere - the official name 
is BVE Object Creator).  

1 Select Create from the menu bar and select Cube to display 
Cube window 

2 Select Vertex option in the Cube window. You should see a 
window like the one above with no values. 

BUILD_045.BMP appears to be a 3-story building (about 3 x 4 
= 12 meters tall) and appears to be as wide, so: 

3 Enter 12 for Length, Width, and Height  

4 Enter 1 for Horz. map rate and Vertical map rate 

5 Enter BUILD_045.BMP into the Map File (bmp) field and 
check the checkbox to the left of the field 

6 Enter BUILD_045.CSV into the Output File field 

7 Click Create Cube  

8. Load the object into Structure Viewer and have a look 
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Now lets change some values.  

1 Make the Width and Length 24 and the 
horizontal map rate 2. Call this one 
BUILD_045WIDE.csv 

2 For a different look, use the same 

BV
How to run Structure Viewer 

Open Structure Viewer. Click 
View and choose Topmost. This 
will keep Structure Viewer always 
on top. Open the VR objects 
folder you have created and move
it so you can see the contents of 
the folder and Structure Viewer 
and the Cube window. Drag the 
file BUILD_045.CSV into 
Structure Viewer. You should now 
see your object. You can use up 
and down arrows on you 
keyboard to zoom in or out on 
your object. Hold the left mouse 
down and move the mouse to 
rotate the object. Hold the right 
hand mouse button down to move
the object up and down. Practice 
with BUILD_045.CSV. Also look at 
the object while you are moving it
around. When done, select File > 
Clear to set up for the next 
object. 
parameters but make the horizontal map 
rate 3 or 4 and call this one 
BUILD_045WIDE2.csv 

3 Look at this one in structure viewer. Clear 
when done. 

Again same parameters, but this time make the height 3 times 
taller at 36 and the vertical map rate 3 and save as 
BUILD_045tall.csv. Look at this on in Structure Viewer. Clear 
when done. You can continue this any way you want and make as 
many variations as you want, but for now, keep the total width or 
length less than 50 meters. 

Now bring your reference track into Structure Viewer. You will 
notice the building is lower than ground level.  

1 Open BVE (Object) Converter 

2 Choose Move X Y Z and put a positive number into the Y 
value. Choose one of the buildings we just created.  

3 Move the building by choosing the building and click Convert. 
This creates a file called (for example) BUILD_045.(M).CSV. 

4 Place this file and your reference track into Structure Viewer 
(see How to run Structure Viewer sidebar). See if the value 
you choose moved the building enough or too much. 
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5. Change the value if needed and move again, refresh (File > 
Refresh) Structure Viewer. (You could also open the original 
file and find what the lowest Y value is and use the negative 
of that value, i.e., if -18, use +18.) 

6. When you are happy, delete the original file and rename the 
file to the original. When done, open the final files and add 
the credit lines. Make sure to add the web site as a credit. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Each file as it is created by Object Creator (aka, Total Sphere, will 
have a built in but blank credit line that is compatible with Route 
Builder�s automatic credit generator: 

;description=Created by Sphere Creator (c) Sanford Mace 2004, 
for 
;Author= 
;Copyright= 

You need to fill in the missing parts like this: 

;description=Building 045 Created by Sphere Creator (c) 
Sanford Mace 2004, for 
;Author=Your Name here,VR Reading Room  Date of 
publishing ,Bitmaps from 
http://amazingtextures.com/textures/index.php  
;Copyright=Open Source with credits 
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The comma between the Author names is important. This is how 
the credits are generated. This way everybody gets the credits they 
are due. Note: my name does not go into the credits file; these 
are YOUR buildings. However, I do insist that the copyright for 
buildings from this article be open source. What you do with your 
own buildings is up to you. 

Paint window. 

 

Other Objects  Before we continue, we are going to use MS Paint to create a few 
more bitmaps.  

1 Open Paint (Start > Programs > Accessories > Paint) and 
create a new bitmap (File > New). This size should be 32 
pixels wide by 64 pixels tall.  

2 Go to Image > Attributes and adjust the Width and 
Height. Then go to View > Zoom > Large Size.  

3 Choose the Fill tool and the black color and fill the box black. 
Then choose the Line tool and choose the color red and the 
middle sized line  

4 Select the Line tool and choose the 2nd or 3rd line from the 
top 

5 Draw a line from the lower left to the middle right and then 
one from the lower right to middle left  

6 Choose the Square tool and make a box around the X  

7 Now do the same thing in white in the top of the image, the 
save the image under the name Tower1 as a 256 color BMP 
image 
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Tower1. 

Now create a new bitmap. This size should be 64 pixels wide by 32 
pixels tall.  

1 Repeat the steps above up to the part where you fill the box 
black 

2 Choose the light gray color and create the image shown here. 
Use brown and the thin line choice for the hang down parts.  

3 Call this one Tower2 

 

 

Tower2. 

 

Do the same steps and create Tower3.bmp, but this time use the 
thin line tool. 

 

 

Tower3. 

Now create a new bitmap. This size should be 64 pixels wide by 32 
pixels tall.  

1 Repeat the steps above up to the part where you fill the box 
black 

2 Choose the light gray color and create the image shown here. 
Use the fine line tool  

3 Save as Cell1 
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Cell1. 

 

Obelisk window. 

 

Making the Objects  Now we are ready to make some objects.  

1 Open Object Creator and choose to Create Cylinder. A 4-
sided cylinder is a cubic object, and here we can choose 
different height at top and bottom, an obelisk.  

2 Choose Vertex for the type of object 

3 Enter 4 into Segments, 1 into Width at Top, 20 into 
Height, and 2 into Width at Bottom 

4 Enter oblisk.csv into Output Name  

5 Enter 192,192,192 into base color of and check box to left 
of base color 

6 Click CreateCylinder  

7 Look at object with Structure Viewer  

8 If you do not like the object, change parameters in Object 
Creator until you are happy 

9 Now place a copy of your reference track in Structure Viewer  
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ou ill notice the obelisk is depressed halfway into the ground. 
We need to move it.  

1 Clear Structure V

2 Open BVE File Converte

3 Chose the obelisk.csv file and choos
the y direction 

Load the file obe
object viewer (Structure Viewer). Looks pretty good.  

Delete the original obelisk and rename the obelisk(MV
obelisk 

we create

1 Change the parameters in Object
meters width at top, 1 meter high and 1 meter bottom width

Keep the same color and enter the name of top.  

3 Click CreateCylinder  

4 Open Object Converter 

5 Choose top.csv and sele

6 Put your reference track, obelisk and top(m) into Structure 
Viewer. Looks better.  

With a text editor, open

8 Copy contents of top(m) file and paste at end of o
(you can delete the header info in the top(m) file if you wish) 

ile should look like this: 

;Moved with BVE File Conver
;description=Created by Sphere Cr
for 
;Aut
;Copyright
  
Cr
;Make vertex  
AddVertex, 1 , 
AddVertex, 0.5 ,  9.5 ,  0 
AddVertex, 0 , -0.5 ,  0.99 , 
AddVertex, 0 ,  9.5 ,  0.49 , 
AddVertex,-1 , -0.5 ,  0 , 
AddVertex,-0.5 ,  9.5 ,  0 
AddVertex,-0.01 , -0.5 , -1 ,
AddVertex,-0.01 ,  9.5 , -0.5 ,
Addface,  0 ,  1 ,  3 ,  2 , 
Addface,  2 ,  3 ,  5 ,  4 , 
Addface,  4 ,  5 ,  7 ,  6 , 
Addface,  6 ,  7 , 1, 0, 
SetColor ,192,192,192, 
GenerateNormals, 
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CreateMeshBuilder, 

 ,  9.5 ,  0 , 

9 , 

 , 

0.5 , 

 

S  Obelisk and we have a decorative obelisk. 

;Make vertex  
AddVertex, 0.5
AddVertex, 0 ,  10 ,  0 , 
AddVertex, 0 ,  9.5 ,  0.4
AddVertex, 0 ,  10 ,  0 , 
AddVertex,-0.5 ,  9.5 ,  0
AddVertex, 0 ,  10 ,  0 , 
AddVertex,-0.01 ,  9.5 , -
AddVertex, 0 ,  10 ,  0 , 
Addface,  0 ,  1 ,  3 ,  2 ,
Addface,  2 ,  3 ,  5 ,  4 , 
Addface,  4 ,  5 ,  7 ,  6 , 
Addface,  6 ,  7 , 1, 0, 
SetColor ,192,192,192, 
GenerateNormals, 

ave the file as name
Delete the top files and add your name to the author line and an 
object description (see above). 
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Radio Tower  Now let us take what we learned and make something more useful. 

The first will be a standalone radio tower (see above for example 
on how to do this).  

1 Choose to Create a Cube using 
Vertex commands.  

You will find 
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2 Length and Width to 4, Height to 
60,   

3 Choose Map File of the name 
tower 1.bmp,Check in front of 
map file name  Horizontal map 
rate 1, vertical rate 6.  

4 Choose transparent color of 
0,0,0 and a name of radio tower.  

5 Choose create cube.  

6 Look at this in structure viewer..  

7  Now open the file radio tower.csv 
in notepad and edit  addface to say 
addface2 and comment out the 
lines with upper face and lower 
face like this ;Addface2,6,2,1,5 ; 

BVE Creator-C
Transparent Color 

that I am going to use 0,0,0 
e transparent color in almost all 
. Any color can be used, but the 
lor has been 0,0,255 (blue). I 
 came from the video concept of 
N, but I do not know. This means 
 us. 

t use true black 0,0,0 as a color 
map, but could use 0,0,1 or 
ue black 

ure Viewer there is a choice under 
XPORT X. This is a new form for 
 this form only 0,0,0 can be used 
arent. We are setting these 
p to be used as X files in the 
Lower Face. I.e. add a semicolon 
to the beginning of the line. 

8 Now we need to taper the top to a width of 2 meters. Open the 
radiotower file in note pad and change the section below  

AddVertex , 2 ,  30 , -2 ; vertex; 0;  
AddVertex, 2 , -30 , -2 , ; vertex; 1;  
AddVertex,-2 , -30 , -2 , ; vertex; 2;  
AddVertex,-2 ,  30 , -2 , ; vertex; 3;  
AddVertex, 2 ,  30 ,  2 , ; vertex; 4;  
AddVertex, 2 , -30 ,  2 , ; vertex; 5;  
AddVertex,-2 , -30 ,  2 , ; vertex; 6;  
AddVertex,-2 ,  30 ,  2 , ; vertex; 7; 

to 
AddVertex , 1 ,  30 , -1 ; vertex; 0;  
AddVertex, 2 , -30 , -2 , ; vertex; 1;  
AddVertex,-2 , -30 , -2 , ; vertex; 2;  
AddVertex,-1 ,  30 , -1 , ; vertex; 3;  
AddVertex, 1 ,  30 ,  1, ; vertex; 4;  
AddVertex, 2 , -30 ,  2 , ; vertex; 5;  
AddVertex,-2 , -30 ,  2 , ; vertex; 6;  
AddVertex,-1 ,  30 , 1 , ; vertex; 7; 

9 That is, make all the lines with positive 30 as the height to have 
an x and y value of 1 instead of 2. Now open the file 
converter, choose move x.y.z and move the file 29.5 meters 
in the Y direction. Load the radiotower(MV) and reference 
track in the structure viewer. If you are happy, delete the 
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radiotower file and rename the radiotower(MV) to radiotower. 
Open the file in notepad and add the credits and description.. 

10 Make a copy of radiotower and call it celltower. Open the 
Object Creator  aka Total Sphere and choose cube in the 
vertex mode. Length  and width are 3 and 3, height 1.. Map 
file is cell1.bmp. Horizontal and vertical map rates are 1. 
Transparent color is 0,0,0 file name is cell. Open in 
NotePad and change addface to addface2. Comment out the 
upper and lower face lines with a semicolon.  

11 Open the file converter and choose cell.csv and move it 58 
meters in the Y direction. (See Above examples for steps) 
Open the cell(MV).csv in notepad and copy the contents to 
the celltower file and save  Repeat this from the open file 
converter line (First line in this paragraph )twice using 52 and 
48 meters for the move Values. Now look at the celltower file 
in Structure viewer.. Delete the working cell files.. Open the file 
Celltower.csv in notepad and add the credits and description. 
See above for steps.. 

Now lets see if you can do this your self. Using the directions for 
the radio tower, create a tower the with a base width of 10 and top 
width of 1  use tower3 as the map file and File name of 
Hightower. Then create a cube file with a height of 2 meters 
length of 6 and width of .1. Map file is tower2.bmp working 
name is cube. Use the file converter to move the object 
CUBE.CSV to the top of the tower,  about 59 meters. Now copy 
the contents of the file to highten tower. Make another one with a 
length of  10 and do the same thing. To a height of 52 meters. . 
Make another one with a length of  10 and do the same thing. to 
a height of 46 meters. Open the file in notepad and add the credits 
and descriptions will leave credit lines to you. This is a high tension 
power tower. 

 

More Buildings  Now lets make some more buildings. (See the examples and 
screen shots above for the HOW TO parts.) For this you will need 
the bit maps downloaded from 
http://amazingtextures.com/textures/index.php .  

We will start with BUILD_019. Open this with Irfanview and resave 
as a BMP file with 512 x 512 or 256 x 256 size. The bigger file 
will look better, but do not make this smaller than 256 x 256 
because we will be using parts of the bitmap.  

Open the Object Creator (aka Total Sphere) and choose Cube, 
Vertex like we did in the first building. Now this a 4 story building. 
One story is about 10 - 12 feet, so we need a 48 foot or about 16 
meter for height. It looks to be about twice, maybe 3 times that 
long so let us use 32 for the width and 16 for the length. Map 
file is BUILD_019.bmp. (Do not forget to put the check in front 
of Map File.) Name of the file will be BUILD_019. (See the 
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screen shot for an example.) Create the object. That looks pretty 
good. You can change any of the size parameters to fit your needs.  

Now load your reference track. We need to raise the building. 
Follow the pattern above to move the file 7.5 meters in the y 
direction. Open the file in Notepad and add the credits and 
description. 

Build_019 window. 

 

Before you leave this building, create 3 more objects. For the first, 
use the same length and width as BUILD_019. But make the 
height be 4 meters and the vertical map rate of -.26 and call 
this one SHOPS. Make another one with the same parameters but 
with a length and width of 8 meters. Call this one SHOP1. We 
will come back to these later. 

For our next building we will use the BUILD_006 bitmap file. 
Follow the pattern above using these parameters: length 32, 
width 16 height 16 map file name BUILD_006.bmp 
Horizontal rate 1 vertical 1 and the name of the file 
BUILD_006-A. Create this and load into structure viewer. This 
does not look quite right, so lets change the values. Length 15, 
width 15 everything else the same. Refresh the view in Structure 
Viewer (File Refresh). This looks better. We will keep this one. 
Use the File Converter and your reference track to move the file to 
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the correct height (try 7.5 meters) and finish with credits and 
description. 

 

Another Building For our next building we will use the BUILD_006 bitmap file 
again. Follow the pattern above using these parameters: length 
15, width 25 height 8 map file name BUILD_006.bmp 
Horizontal rate 1, vertical rate 0.5 and the name of the file 
BUILD_006. Create this and load into Structure Viewer. This looks 
OK, but we only have the top of the building. Open the file in 
Notepad. Make the last part look like this: 

Generatenormals 
LoadTexture, BUILD_006.bmp 
SetTextureCoordinates, 3, 0, .580, 
SetTextureCoordinates, 2, 0,1, 
SetTextureCoordinates, 0, 1, .580. 
SetTextureCoordinates, 1, 1, 1, 
SetTextureCoordinates, 4,  0 , .580, 
SetTextureCoordinates, 5,  0 , 1, 
SetTextureCoordinates, 7, -1 ,.580, 
SetTextureCoordinates, 6, -1 , 1, 

Replace every 0 with .580 and every .5 with 1 in the last section.  

Now look at the file by choosing File Refresh in Structure Viewer. 
This looks much better. Note this is for a truck loading dock. If you 
are using a rail loading dock, make the building height 10 
meters. Now use the file converter to move the file up to look 
good next to your reference track. This one I will leave to you to 
experiment with (start with about 4 meters in the Y direction). 
Follow the pattern on the other files to finish and clean up. 

Before we leave BUILD_006, make a cube with 32 width, 16 length 
1 horizontal map rate and .5 vertical map rate. Call it SHOPTOP 
Make another with a width and length of 16, a height of 8 
horizontal map rate of 1 and vertical map rate of .5  called  
SHOPTOP2. 

 

Pieces and Parts  Now lets use some of the parts we have created. Open SHOPS1 in 
the file converter and make a Y mirror. Choose the file name, pick 
the Y in the Mirror section and click Convert. 
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Mirror window. 

 

This should give you a small, almost square building with the shop 
from the left corner. Now make 3 copies of this called SHOP2, 
SHOP3 and SHOP 4. We will edit the map parameters by hand 
with Notepad to get the rest of the shops. Use these settings; you 
can cut and paste from here to Notepad if you wish: 

SHOP2 
SetTextureCoordinates, 3, .22, .74, 
SetTextureCoordinates, 2, .22,1.00, 
SetTextureCoordinates, 0, .40, .74. 
SetTextureCoordinates, 1, .40, 1.00, 
SetTextureCoordinates, 4,  .22 ,.74, 
SetTextureCoordinates, 5,  .22 , 1.00, 
SetTextureCoordinates, 7, 0.40 , .74, 
SetTextureCoordinates, 6, 0.40 , 1.00, 
SHOP3 
SetTextureCoordinates, 3, .60, .74, 
SetTextureCoordinates, 2, .60,1.00, 
SetTextureCoordinates, 0, .80, .74. 
SetTextureCoordinates, 1, .80, 1.00, 
SetTextureCoordinates, 4,  .60 ,.74, 
SetTextureCoordinates, 5,  .60 , 1.00, 
SetTextureCoordinates, 7, 0.80 , .74, 
SetTextureCoordinates, 6, 0.80 , 1.00, 
SHOP4 
SetTextureCoordinates, 3, .805, .74, 
SetTextureCoordinates, 2, .805,1.00, 
SetTextureCoordinates, 0, 1.00, .74. 
SetTextureCoordinates, 1, 1.00, 1.00, 
SetTextureCoordinates, 4,  .805 ,.74, 
SetTextureCoordinates, 5,  .805 , 1.00, 
SetTextureCoordinates, 7, 01.00 , .74, 
SetTextureCoordinates, 6, 01.00 , 1.00, 
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Finish the credit lines and use the BVE File Converter Version 2 to 
move the files to the correct height. Note that half the walls are 
backwards. This can be fixed, but for now leave them alone. 

Make a copy of SHOPS called TALLSHOPS. Use BVE File 
Converter Version 2 to move SHOPTOP 10 meters in the Y 
direction. Place TALLSHOPS and SHOPTOP into Structure 
Viewer. You should see the shops with a 2-story brick part 
hovering above them. Change the Y value in the BVE File 
Converter Version 2 to a smaller number, do the move and then 
refresh the object viewer. Eventually you will get the two parts 
to join correctly. I will let you figure out the correct value. When 
you have this correct, cut the text from SHOPTOP and paste into 
TALLSHOPS. Continue this process to add 2 more floors until you 
are happy with the building. I did this three times to get a 7-story 
building.  

Note for real world pickers of nits. This is a brick faced building, 
and those generally did not go much above 10 stories or so. When 
done, delete SHOPTOP. You can use the same process with 
BUILD_006-A and SHOPTOP2. You pick the name of the 
building. 

For additional variation on the theme, you could use the BVE File 
Converter Version 2 to move a radio or cell tower to the top of one 
of the tall buildings. 

 

Frivolous But Fun  Now one final thing. The Object Creator aka Total Sphere started 
life as a sphere creator. That is why the name is TOTAL SPHERE. 
There is not much use for this in BVE, but it was a nice project. 
There is one good use for a sphere, and that is as an advertising 
sign. Open Paint and create a 16 x 32 or 32 x 64 bitmap that 
looks like the screen shot below. Save as ACME.bmp. I will leave 
the actual work to you. Note the background color is cyan, 
0.255.255.  

 

 
 

Open the Object Creator aka Total Sphere and go to create 
sphere Vertex. Create a Sphere vertex about 4 meters in 
radius with between 8 and 16 segments. Use outside map. If 
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you want to try a transparent one, use inside map and use the 
transparent color of 0,255,255. Make sure you choose the 
Transparent color box. This will be building sign, the higher and 
further away from the track the fewer segments you will need to 
make it look good. Horizontal rate as 2 vertical as 1, use ACME 
bitmap and call this ACME.  

Acme sign window. 

Use the BVE File Converter Version 2 to move this to the top of one 
of your buildings. Copy the TEXT from ACME(M) to the building file 
and you now have the headquarters for the ACME Corp. (With 
apologies and credits to Roadrunner, Coyote and Warner Brothers). 

 

Fixes & Patches  In the beginning of this article I gave a warning that these are 
rather large objects. You can modify them to be less graphic 
intensive by eliminating the back faces if you do not need them. 
Following is a modified version of BUILD_006.csv that has a 
smaller impact: 

CreateMeshBuilder, 
AddVertex, 7.5 ,  8 , -2 , 
AddVertex, 7.5 ,  0 , -2 , 
AddVertex,-7.5 ,  0 , -2 , 
AddVertex,-7.5 ,  8 , -2 , 
AddVertex, 7.5 ,  8 ,  18 , 
AddVertex, 7.5 ,  0 ,  18 , 
;AddVertex,-7.5 ,  0 ,  18 , 
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;AddVertex,-7.5 ,  8 ,  18 , 
Addface,0,1,2,3 ; Front Face 
Addface,0,4,5,1 ; Right lateral Face 
;Addface,0,3,7,4 ; Upper Face 
;Addface,6,5,4,7 ; Back Face 
;Addface,6,7,3,2 ; Left lateral Face 
;Addface,6,2,1,5 ; Lower Face 
Generatenormals 
LoadTexture, BUILD_006.bmp 
SetTextureCoordinates, 3, 0, .580, 
SetTextureCoordinates, 2, 0,1, 
SetTextureCoordinates, 0, 1, .580. 
SetTextureCoordinates, 1, 1, 1, 
SetTextureCoordinates, 4,  0 , .580, 
SetTextureCoordinates, 5,  0 , 1, 
;SetTextureCoordinates, 7, -1 ,.580, 
;SetTextureCoordinates, 6, -1 , 1, 

You can either comment out the bold lines or delete them. This 
gives a two-face object without a floor or roof. 
 
The following version: (note lines deleted) 
CreateMeshBuilder, 
AddVertex, 7.5 ,  8 , -2 , 
AddVertex, 7.5 ,  0 , -2 , 
AddVertex,-7.5 ,  0 , -2 , 
AddVertex,-7.5 ,  8 , -2 , 
AddVertex, 7.5 ,  8 ,  18 , 
AddVertex, 7.5 ,  0 ,  18 , 
Addface,0,1,2,3 ; Front Face 
Addface,0,4,5,1 ; Right lateral Face 
Generatenormals 
LoadTexture, BUILD_006.bmp 
SetTextureCoordinates, 3, 0, .580, 
SetTextureCoordinates, 2, 0,1, 
SetTextureCoordinates, 0, .64, .580. 
SetTextureCoordinates, 1, .64, 1, 
SetTextureCoordinates, 4,  1.2 , .580, 
SetTextureCoordinates, 5, 1.2, 1, 
, 

gives the two-faced building with loading dock on one side and 
office on the other. 

I will leave more advanced edits to you after looking at the object 
building tutorials sited above. 

 

Wrap Up (Finally) At this point you should have several good usable building objects 
and a path to create more. These are good startup and learning 
tools. You can edit them by hand to learn what make what happen, 
or just use them as they are. Some of them are below. 
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Build_045 

 

 
BUILD_045wide4tall 

 
Shops 
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Shops4 

 

 
Build_06 

 

 
TallShops 
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Acme Building with non-transparent sphere. 

 

Sanford 
Articles and illustrations ©2006 Sanford Mace. All rights reserved. 

 

Visit the VR Reading Room for more articles on virtual railroading. 
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